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UtilityLaunch™ Release Notes

The following changes were made to UtilityLaunch version 2.0.1:

1. Fixed a bug that occasionally resulted in file selection dialogs, such as used
with the Launch... menu item, hanging or crashing when a previously selected disk
was no longer on line.

The following changes were made to UtilityLaunch version 2.0.2:

1. Corrected a bug that appeared to cause custom menu select button creation
windows to disappear when trying to create a custom menu select button on an Icon
Menu. The window was actually dropping behind the Icon Menu window.

2. Corrected a bug that prevented moving of a button between menus using the
Arrange Mode.

3. Fixed an initialization error in menu translation that could result in translated
menus having an incorrect Startup or Shutdown setting.

4. Changed the Launch and Setup program selection filters, as well as the
Options dialog, to optionally recognize only those Text files having an “.EXEC”
extension. This replaces the previous filter that selected no Text files,  short Text files,
or all Text files depending on your default settings. Either the Short Text or All Text
defaults will now activate the “.EXEC” filter. This change should result in more positive
selection of EXEC files.

5. Added a capability to create custom buttons with no icons in any Icon Menu.
Clicking on Cancel in the Icon Selection Dialog will result in a custom button being
created that does not contain an icon. This simple button will be very slightly larger
than an icon button, and can contain a name and be colored just like any other button.
A similar capability already exists, but was undocumented, with the Edit mode (but not
the Insert mode). Selecting a blank (unused) button in the Edit mode then clicking on
Cancel in the Icon Selection Dialog will result in creation of a simple button without an
icon.

6. Added a new capability to extract icons from the resource fork of any extended
file in addition to the previous capability to  extract any icons from a Finder Icon file.
The new file selection dialog now allows for selection of both types of icons. Many
programs have interesting icons as resources in their resource forks. You will be
informed if a selected file has no icon resources in its resource fork. Selecting icons
from a resource fork is slightly slower than selecting icons from an Icon file.



Page 2

The following changes were made to UtilityLaunch version 2.0.3:

1. Added a capability to have a menu set either the Launcher screen color or the
background color upon menu startup. The default is to set the Launcher screen color
on menu startup, which gives you the capability of having different  Launcher screen
colors for different menus, rather than having all menus default to the Launcher screen
color established in the Options... menu item. In some instances you may want to reset
the background color upon return from launching a program (e.g.; if you are setting
background colors with individual P8 programs and want the menu to be reset to
defaults after exiting from the P8 program). You can now merely click on the
“Launcher” text that appears at the top center of the Set Colors dialog, and
background color settings will appear. Clicking on “Background” will in turn select the
Launcher color settings. If you choose “Background”, the menu’s Launcher screen
color will be determined by the color selected in the Options... menu item.

2. Changed alert windows to properly display text messages containing the
character “/” embedded in the text message.

3. Corrected a problem whereby menu names and button names were not always
cleared when a Cancel button was pressed.

4. Corrected a problem where menus were not saved if there were no menu
button changes.

5. Modified the files list for the Launch and Program Select Standard Files
Dialogs.



Page 3

The following changes were made to UtilityLaunch version 2.0.4:

1. Fixed a problem with the Arrange Mode often trashing pathnames, prefixes, and
slot settings when multiple arranges were made with individual buttons.  This problem
also sometimes resulted in custom buttons performing incorrect functions (e.g.; menu
change buttons becoming boot buttons). The logic for the Arrange mode, unlike other
modes, now uses current menu entries, and not saved menu entries, if the menu
entries have been altered. This gives you the capability of making multiple menu
arrangements with individual buttons without saving after each move.

2. Made minor changes in the logic for Save, Shutdown, and Autostart settings.
Previous settings are now only cleared when in the Insert mode.

3. Inserted a Save reminder when switching between modes if any menu entry
has been changed. It is advisable to save menu entries prior to switching modes if any
menu entries have been changed.

4. Changed Password windows and Menu Select windows to fake modal dialogs.
This prevents any other activity from occurring until the desired action is indicated.
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The following changes were made to UtilityLaunch version 2.1:

1. Added a capability to pass file names through the Message Center to programs
being launched.  Several S16 programs, such as UtilityWorks GS, AppleWorks GS,
and HyperCard IIGS, accept input messages which specify the initial file to load. The
file specified must be compatible with the specific application. Most applications
having this capability will have an auxiliary file type of $DB04, $DB05, $DB06, or
$DB07. If an application does have such an auxiliary file type it should accept
Message Center messages. UtilityLaunch allows setting the Message Center
pathname in the ‘Enter Prefix 8:’ startup path dialog. If instead of setting prefix 8 you
desire to enter the Message Center pathname, just click on the ‘Enter Prefix 8:’ text at
the top of the dialog and it will change to ‘Enter Pathname:’.  Enter the pathname
exactly as you would with a P8 program Startup Pathname. You of course can use the
Standard File Selection dialog to make this choice if you desire. For instance, if you
are launching AppleWorks GS simply choose the Message Center pathname that
corresponds to the initial file you want displayed when the program first loads.
Similarly, if you are launching HyperCard IIGS and want a stack other than the Home
stack displayed when you first load the program, simply choose the Message Center
pathname for this other stack. Remember you must change the dialog from ‘Enter
Prefix 8:’ to ‘Enter Pathname:’ to activate the Message Center logic.
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The following changes were made to UtilityLaunch version 2.1.1:

1. Changed the Color Selection Dialog to more easily select  Launcher color or
Background color  when Saving a menu. The choice between launcher color and
Background color is now made merely by clicking the appropriate radio button at the
top of the dialog.

2. Changed the Startup Path Dialog to more easily select Prefix 8 pathname or
Message Center pathname with S16 programs. The choice between Prefix 8 and the
Message Center is now made merely by clicking the appropriate radio button at the
top of the dialog.

3. Made minor changes in the filelist for Standard File tools.

4. Precluded all initial segments from loading into special memory to avoid
potential problems in establishing the SHR screen.
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The following changes were made to UtilityLaunch version 2.1.2:

1. Changed the Insert mode to delete the button color and icon before inserting
the new program settings and icon. The Insert mode in effect now functions as a
Delete mode followed by an Edit mode program selection.

2. Corrected a bug that caused erroneous program pathnames in unusual
situations.

3. Corrected a bug that occasionally resulted in an incorrect return from defProcs.
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The following changes were made to UtilityLaunch version 2.2:

1. Fixed a minor bug in a routine used to check the existence of selected prefixes.

2. Fixed a minor bug in the Shutdown routine to properly dispose of the direct
page.

3. Fixed a major bug in the File Selection Filter Proc used to both select programs
to be included in menus in the Setup mode as well as to select programs to directly
launch in the Launch... menu item.  This bug resulted from not using long addressing
in one specific instance in the Filter Proc. In some cases this resulted in a memory
location in the GS/OS system area being zapped. If you had unexplainable errors at
times when using UtilityLaunch this could well be the problem. This error does not
occur menus are being set up or changed, or programs are being directly launched.

4. A capability has been added to allow saving of almost any screen image when
using UtilityLaunch. It works much as the OA-H capability which prints almost any
screen image. Simply use OA-D to save the desired image. You will be presented with
a Standard File dialog to select the directory and file name.

5. Added a new capability to control the ZIP GS (TM) speed and delay settings. If
you have a ZIP GS present, UtilityLaunch will read its maximum speed and put three
additional radio buttons in the Setup routine’s Slot/Speed selection dialog.   The ZIP
GS capability works much like the TransWarp GS capability, and allows unique ZIP
GS settings for any program being launched, as well as default ZIP GS settings for any
menu. The Slot/Speed selection dialog allows you to choose standard IIGS speeds of
either 1.0 MHz (normal) of 2.6 MHz (fast). If you select either of these two settings,
UtilityLaunch will turn the ZIP GS off and set the desired IIGS speed. The third setting
is the maximum ZIP GS setting (full speed). It will probably read 8.0 MHz, 10.0 MHz, or
12 MHz depending on your ZIP GS’s maximum speed.  If you select this setting
UtilityLaunch will set the IIGS to fast speed and set the ZIP GS to 100% speed with no
AppleTalk delay. The fourth setting (X.X MHz(AT)) allows you to easily set up
AppleTalk at the fastest possible speed. UtilityLaunch determines the proper speed
setting (you will usually see 6.8 MHz to 7.0 MHz) based upon the maximum speed
available on your ZIP GS. Selecting this setting results in UtilityLaunch setting your
IIGS to fast speed and setting your ZIP GS to the proper AppleTalk speed as well as
setting the AppleTalk delay. Please note that recent enhancements in the ZIP GS INIT
file may allow your Apple IIGS to operate with AppleTalk at full speed without any
AppleTalk delay. The last ZIP GS setting (Current) allows you to select any desired ZIP
GS speed or delay. Before clicking on the Current radio button, set your ZIP GS to the
desired speed and desired delays for the selected program using either the ZIP CDev,
CDA, or NDA. Only the CDA is usable if you desire to set the ZIP GS settings while in
the Slot/Speed selection dialog. Now click on the Current radio button (even if it
indicates it is already selected). Clicking on the Current radio button reads all current
ZIP GS settings and saves them for use when launching the selected program. Now
restore the ZIP to your normal settings (again using the CDev, CDA, or NDA) and Save
the menu after selecting the menu default speed settings. Make sure you click the
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Current radio button to read your menu default ZIP GS settings. Now whenever you
launch the program that you have just set up, UtilityLaunch will set the custom ZIP GS
settings. Upon exiting the program and returning to UtilityLaunch, the default settings
will be re-established. The procedures for setting up these Custom ZIP GS settings are
a little cumbersome, but you should seldom, if ever, need to use them. I have found no
programs or hardware yet, other than AppleTalk, that don’t work with the ZIP GS
settings as shipped, and even AppleTalk now works at full speed with the new ZIP INIT
file. Although I have not done an extensive test of programs, my testing does include
the PC Transporter (I understand the 5 1/4 inch drives connected to a PC Transporter
may require the ZIP GS card to be turned off to operate properly) and a number of
other cards and programs. My ZIP GS is a 10 MHz version with 64K of cache, and it is
very FAST and totally DMA compatible. Please let me know if you have any
suggestions of further ZIP GS capabilities you would like to see in UtilityLaunch. I wish
to thank Tony Vece of ZIP Technology and David Ely, author of the ZIP CDev and
CDA, for their help in developing the UtilityLaunch ZIP capability.
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The following changes were made to UtilityLaunch version 2.2.1:

1. Corrected the Page Setup... item name in the File Menu

2. Corrected a bug whereby custom buttons (Customize mode) overwriting
previous program buttons did not properly delete program pathnames. This could
result in erroneous action if you should attempt to install a custom button over an
existing launch button.

3. Added a capability to Save and Restore the control panel. Two items have been
added in the Utilities Menu (Save Panel and Restore Panel). These items are useful
for restoring your Apple IIGS control panel to your desired default configuration.
Simply set up your Control Panel to your desired default configuration using the
Control Panel CDA or CDev. Now press Save Panel. The current Apple IIGS Control
Panel settings will be saved as a resource in your UtilityLaunch menu resource fork. If
for some reason your Control Panel settings get messed up simply press the Restore
Panel and your previous Control Panel Settings will be restored. The Restore Panel
item is dimmed unless the Control Panel has been previously saved. Please note that
the restored Control Panel will not become effective until you reboot the Apple IIGS.
Please also note that the Control Panel will not be restored if you generated the saved
Control Panel on a ROM 01 computer and attempt to restore it on a ROM 03 computer,
or vice versa.

4. Added a capability to automatically choose the RPM printer driver for menu
setting printout if you are printing over AppleTalk. In all other instances the Serial
Printer driver will be selected.

5. UtilityLaunch now uses a different boot routine for booting slots if the AppleTalk
FST is active. If the AppleTalk FST is not active the previous boot routine will be used.
This chance was necessary to prevent unserviced AppleTalk interrupts from
preventing the boot.

6. Added a capability to use UtilityLaunch from a file server over an AppleTalk
network. UtilityLaunch keeps its menu file resource fork open with write access
privileges to allow modification of the menus during menu setup. This will prevent
multiple users from utilizing UtilityLaunch at the same time, as may occur when using a
file server. (UtilityWorks does not have this problem and should be operable from a file
server without the following special actions required for using UtilityLaunch from a file
server). A new capability has been added to UtilityLaunch to permit its operation from
a file server with multiple users. To use UtilityLaunch from a file server first change its
access privileges to disallow write access (you can do this with UtilityWorks). Now
place it in the desired file server directory (you can make it the initial Start program if
you so desire). Make sure that you don’t copy the UL.Menus file to this directory. Place
your private UL.Menus (you can call it any permissible name) file in your own directory
on the file server. Now when you first run UtilityLaunch you will be asked to select your
UtilityLaunch menu using a standard file selection dialog. Select the directory and file
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that is your menu and this file will be used for your menu selections. This selection will
remain in effect until you reboot your Apple IIGS.

7. Fixed a bug in the Launch... item of the File menu which prevented the launch of
EXEC files.

8. Fixed a bug in the Color Buttons mode screen color which displayed the wrong
launcher screen color when switching menus.
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The following changes were made to UtilityLaunch version 2.2.2:

1. Changed the name of the Goodies menu to Utilities which is more descriptive of
the items in this menu. All documentation has been revised to reflect this new name.

2. Added the Font Manager to the list of tools that are loaded and started by
UtilityLaunch to be more compatible with NDAs. Apple recommends, but does not
require, that the Font Manager be started by all applications for maximum compatibility
with NDAs. UtilityLaunch now starts all tools that are likely to be required by most
NDAs.

3. UtilityLaunch now sends the name of the document being printed to AppleTalk.

4. Added a Sleep item to the File menu. This item blacks out the IIGS screen in the
same manner as the Screen Blackout Timer, but does so immediately.

5. A blacked out screen will now be restored by any movement of the mouse, in
addition to pressing the mouse button or any key.

6. Changed the names of the internal slots in the Slot Selection Dialog and the
Show Dialog to be more descriptive of the actual functions performed. The new names
used for internal slots 1 through 7 are Printer, Modem, 80-column (Built-in Text
Display), Mouse Port, Smart Port, Disk Port, and AppleTalk respectively.

7. Changed the Startup Slot Dialog, Show Dialog, and slot selection routine to
add AppleTalk as a valid Startup Slot (only appears with  ROM 03 machines).

8. Added a new set of radio buttons to the Set Modem and Set Printer dialogs on
ROM 03 machines only. These new buttons give the user the capability of setting slot 1
to an AppleTalk Port or a Modem Port (in addition to the Slot Selection Dialog choices
of Printer Port and slot card), and setting slot 2 to an AppleTalk Port or a Printer Port (in
addition to the Slot Selection Dialog choices of Modem Port and slot card). Please
note that on ROM 03 machines, unlike ROM 01 machines, it is not necessary to set slot
7 to AppleTalk to use AppleTalk on slot 1 or slot 2. (Never set both slot 1 and slot 2 to
AppleTalk). Please be aware, though, that some programs using AppleTalk may still
require slot 7 to be set to AppleTalk to function properly. Likewise on ROM 03
machines it is not necessary to set slot 4 to Mouse Port to use the mouse.

9. Now turn the SHR screen off and display a Text Screen Mount Volume
message if there are any errors during initial tool loading.
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The following changes were made to UtilityLaunch version 2.2.3:

1. The key combination OA-Q is now used to initiate a Shutdown, rather than
Quitting UtilityLaunch.

2. A bug in the Arrange Mode that sometimes resulted in corrupted menu settings
has been corrected.

3. The installation process for selecting icons has been improved. UtilityLaunch
now allows selection of additional icon files rather than just aborting the button setup if
the selected file does not contain the icon you desire. In the Edit mode only, if you
Cancel from the icon    file     selection dialog, a simple button with no icon will result. If you
Cancel from the icon selection dialog (the one that shows the icons), the icon    file    
selection dialog will be repeated to allow selection of another icon file. If you press OK
in the icon selection dialog, the displayed icon will be used for the button.

4. Fixed a bug that required an initial UL.Boot file to be present in the directory
containing UtilityLaunch to boot any disk.

5. Fixed a Printer Error Message bug that occasionally displayed garbage in
printer error messages.

6. Improved the button setup process when setting up special button options such
as slot settings, speed settings, color settings, etc. Previously, the setup dialogs had to
be gone through in sequence to arrive at the dialog you desired to change. With
UtilityLaunch version 2.2.3 and later, a new dialog is displayed immediately following
the button name selection dialog. This dialog allows choosing only those setup
options desired. The new dialog gives the following choices:

1. Set Slots/Speed
2. Set Colors
3. Set Modem Parameters
4. Set Printer Parameters
5. Set Boot Slot
6. Set Startup Path (for SYS programs), or

Set Prefix 8/ Message Center (for S16 programs)

7. SYS and S16 files file type information is now retained in all instances to allow
setting startup paths, prefix 8, and message center pathnames in the Edit mode.

8. Menus that have not been saved are no longer displayed in the Menus menu
while in the Launcher mode. Only previously saved menus are displayed, which
should speed up the menu selection process. All menus are still displayed in the
Setup mode.

9. The menu Selection pop up window, used in several dialogs, now only shows
previously saved menus, except for the Save As option, which displays all 50 menus.
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10. An option has been added to the Options menu item to enable/disable the
menu bar clock. This should provide compatibility with NDAs writing a menu bar clock.

11. Code has been added to prevent the screen from being immediately blanked
upon return from a long menu setup that exceeds the value of the screen blackout
timer.
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The following changes were made to UtilityLaunch version 2.2.4:

1. Fixed an error in the Icon Select Dialog title.

2. Fixed a Boot Reference Number error.

3. Now reset the output device to slot 3 prior to any text screen display (e.g.;
Launching... message) to avoid conflicts with NDAs that change the output device but
don’t restore it.

4. Corrected an error that only occurred when printer error messages were
displayed.

5. Reassigned the Q keyboard equivalent to the Quit menu item to be consistent
with Apple’s Human Interface Guidelines and avoid conflicts with programs that
depend on this assignment. Added a new B (for “BYE”) keyboard equivalent to the
Shutdown menu item.

6. Changed the file type and auxiliary type assignment for UtilityLaunch menus.
Apple has established the file type $5A (CFG) and auxiliary type $8023 (known as
UtilityLaunch preferences) for all UtilityLaunch menus. UtilityLaunch will now
recognize this new assignment. With version 2.2.4 and later, UtilityLaunch permits the
use of multiple menu files (for instance you could have a separate menu file for each
member of your family). To use this feature, make sure the UtilityLaunch program itself
is write disabled and make sure there is no menu file in the UtilityLaunch directory with
the name of UL.Menus. Whenever you first run UtilityLaunch after a new boot you will
now be presented with a standard file selection dialog that allows you to choose any
UtilityLaunch menu having the new file type/auxiliary type assignment. You can easily
use UtilityWorks to make the file access, filename, and file type changes described
above.
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The following changes were made to UtilityLaunch version 2.2.5:

1. Updated the About UtilityLaunch, Select Icon, Set Defaults, Set  Colors, Show
Menu Entry, and Set Desktop Color dialogs, as well as the Status Window used in the
translation and print routines, to work properly with the video keyboard or any other
windows or dialogs that may appear in front of these windows and dialogs. Added a
Copyright dialog selectable from the About UtilityLaunch dialog.

2. Changed wording on Speed Up menu item and dialog.

3. Added an assembly language routine to speed up slightly the setting of slots
and the display of icons.

4. Changed the password. Registered users can obtain the new password from
the author, George Wilde. A Shareware Alert message is now displayed at
UtilityLaunch Quit and Shutdown in addition to the Shareware Alert message
displayed at initial UtilityLaunch execution.

5. The Shutdown reboot dialog is now displayed on a SHR screen instead of the
previous Text screen. Also eliminated the brief switch to the Text screen that previously
occurred in the Speed Up and Set Desk Color routines.

6. Changed the Clear Power-up Byte checkbox in the Set Launcher Slots dialog
to read “Resize RAM after Reset” to be more descriptive of the function actually
performed and to be consistent with FINDER terminology.

7. Added three additional dynamic load segments and repartitioned UtilityLaunch
to provide better performance in minimal memory configurations. Added a dynamic
segment unload routine.

8. Now test version of operating system to see if System 6 is present. Changed
launch setup of BASIC, Binary, and EXEC files to be consistent with System 6 if it is
present.  Note: This capability has not been tested with any version of System 6.
Therefore, it may require update once System 6 becomes available.

9. Added two menu items to allow creation of Printer Setup resources. Add Printer
will allow the saving of up to ten Printer Setup resources. Delete Printer will delete any
of the ten printer resources. The printer resources give the user the ability to change
printers while launching programs. For instance, you may desire to use the standard
ImageWriter Printer Driver for most programs, but use the special ImageWriter.CL
Printer Driver when running AppleWorks GS. UtilityLaunch now allows you to switch
among up to ten printer drivers when launching programs. To accomplish this, you
must first enter all desired Printer Setup resources. Select the desired printer driver in
the Control Panel NDA. Next select Printer Setup in the Files menu to make sure the
desired printer setup is correct. Now add a printer to either a vacant printer slot or
overwrite a previously established slot using the Add Printer menu item in the Utilities
menu. Enter a descriptive name for this Printer Setup configuration. This name is what
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you will later use when selecting the Printer Setup file to use when launching any
program. The Delete Printer menu item will delete any previously established Printer
Setup resource. To actually change the Printer Setup file when launching a program
or changing a menu, check the Set Printer Driver checkbox in the Choose Desired
Actions dialog. A pop-up menu will appear which allows you to choose any previously
entered Printer Setup resource for use with the program being launched or for use
with the menu in general. Note that although the Printer Setup file is immediately
changed whenever the corresponding button is pressed, in most cases the changes
will not be recognized until the program being launched is actually executed.

10. Added an option to the Set Colors dialog to allow use of either the standard
translation table or no translation table for any program being launched. The standard
translation table allows use of the option and option-shift keys similar to the Macintosh
computer. If you select no keyboard translation, no keyboard translation will be made,
an the option and option-shift key combinations will have no effect.

11. Added a Set Driver Path option to the Choose Desired Actions dialog to allow
installing a device driver from either a  button or when launching an S16 program. The
pathname of the driver can be either manually entered or selected with a Standard
File dialog. Drivers for such devices as Apple 5.25” disk drives can be inhibited from
loading using a program such as UtilityWorks. With slot 6 set to Disk Port and the
Apple 5.25” device driver inhibited, you can avoid the lengthy slot 6 polling that occurs
with many S16 programs. The 5.25” drive is still available for P8 programs because
they don’t use the GS/OS device drivers. If you have a program that requires this 5.25”
device driver, you can easily set up the launch settings for that  program to load the
driver just prior to program execution.

12. Fixed a bug in the Select Printer Dialog to properly cancel all actions when the
cancel button is pressed. Also fixed a bug in the Custom Buttons routine which
sometimes resulted in the previous button not always being erased when the cancel
button was pressed.

13. Added a wait cursor to the translation and slot set routines to indicate that
processing is still taking place.

14. Added the UtilityLaunch standard menu type/auxiliary type files to the Resource
Translation Standard File dialog.

15. Now do not switch to the Text Screen when using either the Speed Up or
Desktop Colors routine, or when shutting UtilityLaunch down.

16. Changed the Resource Print routine to print the newly added Printer Setup and
Control Panel resources. Also now import Printer Setup resources as long as no other
Printer Setup resources currently exist. Control Panel resources are not imported.

17. Removed the Park Heads routine. Most modern disk drives automatically park
their own heads, and this routine could result in minor anomalies when several hard
disk drives are present.
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The following changes were made to UtilityLaunch version 2.2.6:

1. Fixed a bug in the Setup mode whereby the Shutdown Select Action dialog did
not appear. Only the Set Slots/Speed dialog appeared.

2. Now do not switch to the Text screen when launching P16 applications using
the Desktop (i.e.; those applications with an Auxiliary Type of $DB02, $DB03, or
$DB07). This change was made for direct launch from the Files menu Launch menu
item, for Autolaunch, and for Launch buttons. When launching with the Desktop still
visible on the SHR screen, the name of the program being launched replaces the
menu bar entries.

The following changes were made to UtilityLaunch version 2.2.7:

1. A Wait Cursor is now used when opening icon resources in the Select Icon
dialog. The display of icon resources has been speeded up considerably, and a bug
has been fixed whereby certain extended files having icon resources would
occasionally hang when selected. Another bug has been corrected that resulted in
incorrect action if the extended file containing icon resources was already open. If you
select an extended file containing no icon resources the exit is now made back to the
Select Icon dialog rather than the previous exit from the button setup routine.

The following changes were made to UtilityLaunch version 2.2.8:

1. Autostart can now be bypassed by holding down the Open-Apple key as the
GS/OS Startup splash screen disappears following GS/OS boot.

2. Corrected a minor anomaly in initial menu selection when operating under
access control, whereby no menu was installed if the default or shutdown menu was
access controlled. Now if this happens, all menus are searched and the first one with
unlimited access is used as the initial menu.

3. Several additional menu items are now dimmed if access control is in effect.
These include Speed Up, Page Setup, Print, Boot, Add Printer, Delete Printer, Save
Panel, and Restore Panel.
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The following changes were made to UtilityLaunch version 2.2.9:

1. If the user selects “No” in the Set Shutdown Initial Menu dialog box,
UtilityLaunch will now return to the currently selected menu after a program has been
launched. This will continue until a new menu is selected or the computer is rebooted.
This feature gives the user yet another way to select the initial UtilityLaunch menu. You
can still specify, for any menu screen, that UtilityLaunch should return to any menu you
desire following a program launch.

2. Override of Access Control by entering the access password will now remain in
effect until the next computer boot or the next time a menu is selected during menu
shutdown (which is set in the Set Shutdown menu item).
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The following changes were made to UtilityLaunch version 2.3:

1. Added flag to retain the Menu Bar contents when launching a program under
System 6.

2. Added a startup flag to prevent a momentary flash to black when launching a
program under System 6.

3. Revised the dialog update routines slightly.

4. Changed my area code in the Copyright dialog from Area Code 213 to Area
Code 310.

5. Changed the Options dialog to include a “Park Heads on Shut Down” selection.
Most modern drives automatically park their heads so you probably don’t need to use
this option. If you select this option the action taken is dependent on the type of drive
you have. If you have a non-SCSI hard drive the drive’s heads are positioned over the
last track of the last partition on the drive to minimize potential damage to  tracks
containing  programs or data.  If you have a SCSI hard drive a SCSI Stop Unit
command is issued, which with most SCSI drives will park the heads and shut the unit
down. Since this action will probably put your boot drive off line you may get a
message to insert your boot disk. You can ignore this message and turn your computer
off or you can press Cancel to get the standard Shut Down dialog. Rebooting at this
time will turn your hard drive back on, but it may not come up to speed quickly enough
to avoid the “Startup Unit not Found” message. If you get this message simply perform
an Open-Apple -Control-Reset (Command-Control-Reset in the new Apple
terminology) boot to continue.

6. Changed the Eject routine to automatically eject all removable volumes on shut
down, not just the 3.5” disks. This routine is not used with System 6 because System 6
automatically ejects all removable volumes on shutdown.

7. Changed the Launcher Color setting in the Options dialog to a Color Bar to
facilitate easier selection of the desired Launcher Color setting. Just click on the
desired color. The current setting is indicated by a framed color box.

8. Changed the Button Color settings in the Set Button Color dialog to Color Bars
to facilitate easier selection of the desired Button Background and Text Color settings.
Just click on the desired Background and Text colors and observe the resultant colors
on the sample button. The current settings are indicated by framed color boxes.

9. Added a new System 6 call to automatically poll most devices once a second. If
an unformatted disk is inserted, a dialog will appear asking to either initialize (format)
the disk or eject it.

10. Changed the appearance of all dialogs to conform with Apple’s latest Human
Interface Guidelines. When System 6 is present the AlertWindows will also conform
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with these guidelines.  The buttons at the bottom of the dialog will generally have the
action button on the right and the Cancel button (if any) immediately to the left.
Pressing enter or return will select the default (bold-outlined) button (usually, but not
always, the action button). Pressing esc or Command-period will select the Cancel
button if one exists. I Beam cursors will appear if the cursor is positioned over an Edit
Line item. With AlertWindow dialogs you can type the first letter of a button name
instead of clicking on it (unless some other button’s name has the same first letter).
This works with or without the Command key.

The Standard File dialog also supports keyboard equivalents with System 6. You can
use the up and down arrow keys to select various items in the list. You can also type
one or more characters (including the beginning character of an item) to jump the
selection down to that item. (To use the first several characters of an item name, you
have to type one letter every two-thirds of a second or faster). Command-Tab moves to
the next volume. Command-period is the Cancel button, but esc isn’t in the Standard
File dialogs. Esc and Command-up-arrow are equivalent to the Close button (moving
the directory one level closer to the root directory). Command-esc or Command-D
jumps to the Volumes list. Clicking on the path item at the top of the list displays a pop-
up menu with one item for every level in the current path, all the way to the Volumes
list. Selecting any of these items takes you to the corresponding directory. Command-
O and Command-down-arrow are the Open button. In Save dialogs where you enter a
file name, Tab chooses between the edit line and the file list. Keystrokes go to
whichever one is active.

11. Corrected a bug in the nomenclature and logic used when entering a Startup
Path for SYS file types.

12. Restored the setting of Prefix 0 to the directory of the program being launched
for any P8 program launched from the File menu bar. This capability had been
eliminated in recent versions of UtilityLaunch because it is not required by Apple
standards. Unfortunately, many P8 programs still require that Prefix 0 be set to the
directory of the program being launched.  All other settings of prefixes less than 8 have
been removed.

13. Changed the Show Mode dialog slightly to indicate ZIP GS and TransWarp GS
speeds more clearly.

14. Now allow icons for buttons to be of any size. If they are larger than the button
size, they will be reduced in size to fit. This will obviously loose some quality if large
reductions are made.

15. The menu bar clock is now active in almost all windows and dialogs.

16. Added a down arrow in the pop-up menus.

17. Added keyboard support to allow navigating through the buttons in any menu
and selecting programs to be launched without using the mouse. Pressing any letter
key on the keyboard will select the next button in the menu whose title begins with that
letter (this search is case insensitive). Pressing the up or down arrow key will move the
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selected button up or down by one position. Pressing the left or right arrow key will
move the selected button left or right by one position. Pressing enter or return will
launch the selected (highlighted) button.

18. Added several resources to UtilityLaunch to facilitate better use in conjunction
with the new System 6 Finder. rIcons have been prepared for the UtilityLaunch
program, the UL.Menus files, and the Boot file. rVersion, rComment, and rBundle
resources have also been prepared for use with the System 6 Finder or UtilityWorks
version 2.0 or later. Launching UtilityLaunch the first time from the new Finder will
install the UtilityLaunch rBundle. After the rBundle is installed, double clicking on any
UL.Menus file (regardless of what it is named) from the Finder will launch UtilityLaunch
with the selected menu as the current UtilityLaunch menu.

19. A reduced size version of UtilityLaunch that will easily fit on a single 800K
System 6 Boot Disk has been created and included on the UtilityLaunch distribution
disk. This reduced size version is called MiniUL. MiniUL includes essentially all of the
UtilityLaunch Launcher mode capabilities, but none of the UtilityLaunch Setup mode
capabilities. Menus for MiniUL must be created by the full-up version of UtilityLaunch.
Once these menus have been created they can be easily copied to the directory that
contains MiniUL.

20. Several System 6 Installation scripts have been included on the UtilityLaunch
distribution disk. Simply run the System 6 Installer program with the UtilityLaunch disk
on-line in one of your 3.5 inch drives.

The first script will create a System 6 Boot disk containing UtilityLaunch (renamed
START) and an empty UL.Menus file. This Boot disk does contain the SCSI hard disk
drivers to permit access to your hard disk after booting this 800K boot disk.

A second script installs UtilityLaunch on a hard disk already containing System 6
without disturbing the separate UL.Menus file contained on the hard disk. Use this
script to simply replace the UtilityLaunch program without having to regenerate the
menus. (Note: Menus must be contained in the separate UL.Menus file and not the
resource fork of UtilityLaunch to avoid destroying menus with this script). To boot into
UtilityLaunch after installing with this script, use the Startup Path Control Panel to set
UtilityLaunch as the Startup path.

A third script functions identically to the above script but also copies an empty
UL.Menus file to the directory containing UtilityLaunch. This is the preferred script if
you are initially installing UtilityLaunch to a hard disk. Just remember that this script
will destroy any past menus you have created.

A fourth script installs UtilityLaunch on a hard disk already containing System 6, and
replaces the existing START program with UtilityLaunch (renamed START). Menus will
not be destroyed unless they are contained in the resource fork of the previous START
program. The difference between this script and the second script is that the START
program will be replaced by UtilityLaunch (renamed START) rather than creating a
separate file called UtilityLaunch. If you have installed the Startup Path Control Panel
with System 6, you can have any program be your startup program simply by
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specifying it in the Control Panel. In this way you don’t have to replace the START
program. Simplify set the Startup Path to UtilityLaunch.

The above scripts will simplify your UtilityLaunch installation process considerably
when running with System 6.

21. The UL.Menus file in the System Directory contains several samples of Button
and Icon menus. Several additional examples have been added in this update.

22. All Stop, Caution, and Note Alerts have been converted to AlertWindows.

23. Added a check to ensure that the prefix or pathname is valid when using Set
Prefix 8, Message Center, or Set Driver options. This check is not made with the
Startup Path because that path could be an IBM path when using the PC Transporter.

24. The previous Status Window comment “Press Apple-period to Cancel” has
been changed to “Press Command-period to Cancel” to be consistent with Apple’s
desire to refer to the Open-Apple key as the Command key.

25. The key sequence to Save the SHR Screen Image to disk has been changed in
UtilityLaunch 2.3 and later from the previous OA-D to OA-J. This was done to avoid
confusion with the use of OA-D in Standard File dialogs to select the Volumes button.

NOTE: UtilityLaunch version 2.3 should be totally compatible with System Disk 6 and
will take advantage of the seamless SHR screen transition if System 6 is present and
you are launching a Desktop application with the proper Auxiliary Type. If you have a
Desktop application which does not contain the proper Auxiliary type ($DB02 :
Desktop Application) you can change it using UtilityWorks. Just make sure the
application is truly a Desktop application.
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The following changes were made to UtilityLaunch version 2.3.1:

1. Changed the Print Screen and Save Screen routines to use the current screen
display buffers wherever they are located.

2. Added an Alert Window on Shut Down which appears if the Resize RAM flag is
set to give the user the opportunity to either Resize the RAM and Reboot or Shut
Down.

The following changes were made to UtilityLaunch version 2.3.2:

1.      Several changes were made in the driver installation routine to more reliably
install drivers. No attempt will now be made to install a driver that has already been
installed.

The following changes were made to UtilityLaunch version 2.3.3:

1. A minor bug in the UtilityLaunch rBundle was fixed and the version number was
updated.

2. An improvement was made in menu setup regarding the default folder used for
the file selection and icon selection dialogs. Now the file selection default folder will be
the same file folder as was used previously in this session, and the default icon
selection folder will be the same icon folder as was used previously in this session.
This feature should save some time in setting up menus since icons are normally
contained in a single folder.

The following changes were made to UtilityLaunch version 2.3.4:

1. The Screen Blackout Timer no longer blanks the screen upon expiration of the
timer if an NDA is present in the front window.
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The following changes were made to UtilityLaunch version 2.4:

1. A correction was made to the UtilityLaunch rBundle. In accordance with Apple
guidelines no optional descriptor is used except for UL.Boot.

2. Changed all references to "volume" to "disk" to be consistent with Apple's new
naming conventions in System 6.0.1.

3. Corrected a problem in the UtilityLaunch Scan routine which could occur when
reading directories on servers. You should no longer get an Error 61 indicating the
end of the directory has been reached.

4. Corrected the Startup Path routine to ensure that the P8 application conforms to
the Apple Standards for Startup Paths and has an adequate buffer size for the Startup
Path before inserting the Startup Path in the Startup buffer. Please note that with
System 6 it is preferable to set the Message Center rather than the Startup Path with
the prefix of the desired directory. GS/OS will place the Message Center prefix in the
Startup buffer when the ProDOS 8 application is launched. With the PC Transporter it
is probably still necessary to use the Startup Path to insert the MS-DOS application to
run into the Startup buffer of AEPC.System.

5. Command F brings up the control panel's Find File NDA with System 6.0.1.


